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1 Important information

1.1 Copyright and Disclaimer
All rights reserved. The product information and design disclosed herein were originated by and are
the property of Bosch Security Systems, LLC. Bosch reserves all patent, proprietary design,
manufacturing, reproduction, use and sales rights thereto, and to any article disclosed therein, except
to the extent rights are expressly granted to others.

No part of this document may be reproduced or transmitted in any form by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written permission of the
publisher. For information on getting permission for reprints and excerpts, contact Bosch Security
Systems, LLC.

All other trademarks are property of their respective owners.

The content and illustrations are subject to change without prior notice.

1.2 Notices

The lightning flash and
arrowhead within the triangle is
a warning sign alerting you of
dangerous voltage inside the
product.

Caution: To reduce the risk of
electric shock, do not remove
the cover. No user-serviceable
parts inside. Refer servicing to
qualified service personnel.

The exclamation point within
the triangle is a warning sign
alerting you of important
instructions accompanying the
product.

See marking on bottom/back of product.

!

Warning!
Apparatus shall not be exposed to dripping or splashing and no objects filled with liquids, such as
vases, shall be placed on the apparatus.

!

Warning!
The main power plug must remain readily operable.

!

Caution!
To reduce the risk of electric shock, grounding of the center pin of this plug must be maintained.
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!

Warning!
To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

!

Warning!
To prevent injury, this apparatus must be securely attached to the floor/wall/rack in accordance with
the installation instructions.

This product is DC only.

CE Compliant and UKCA Certified

!

Warning!
This is a CLASS A product. In a domestic environment, this product may cause radio interference, in
which case the user may be required to take adequate measures.

1.3 FCC Information & Industry Canada
These devices are accepted under United States Federal Communications Commission Part 15. This
device complies with Part 15 of the FCC. Operation is subject to the following two conditions:
– This device may not cause interference
– This device must accept any interference, including interference that may cause undesired

operation of the device

i
Notice!
Changes or modifications made by the user could void the user's authority to operate the equipment.

The beltpack is intended to be worn on the belt of the user or connected via lanyards hanging down
over the chest. Placing the beltpack in any other location on the body may reduce performance and
void the user's authority by the FCC to operate the equipment.

Business Equipment for commercial or professional use
This equipment has been tested and found to comply with the limits for a Class A
device, pursuant to Part 15 Subpart B of the FCC, Canadian ICES‑003 and CE
requirements. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency and energy. If not installed
and used in accordance with the instruction manual, this may cause harmful interference
to radio communications. Operation of this equipment in residential areas is likely to
cause harmful interference, in which case the user will be required to correct the
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interference at their own expense. Intentional or unintentional changes or modifications
not expressly approved by the party responsible for compliance shall not be made. Any
such changes or modifications may void the user’s authority to operate the equipment. If
necessary, the user should consult the dealer or an experienced radio/television
technician for corrective action.

Mandatory Safety Instructions to Access Point Installers and Users
1. The antenna minimum safe distance, for an access point, as set by the FCC is 20 cm. Antenna

gain: 1 dBi. The antenna are within the upper housing of the access point.
2. The FCC (Federal Communications Commission) has adopted a safety standard for human

exposure to RF (Radio Frequency) energy, which is below the OSHA (Occupational Safety and
Health Administration) limits.

3. To comply with current FCC RF Exposure limits, the access point must be installed at or
exceeding the minimum safe distance show here, and in accordance with the requirements of the
antenna manufacturer or supplier.

4. Antenna substitution: Do NOT substitute any antenna for the ones installed within the access
point by the manufacturer or radio dealer. Substituting an antenna may expose a person or
persons to harmful radio frequency radiation. Contact the radio dealer or the manufacturer for
further instructions.

!

Warning!
Maintain a separation distance from the access point to person(s) of at least 20 cm.

5. As the qualified end user of this radio device, control the exposure conditions of bystanders to
ensure that the minimum separation distance (above) is maintained between the access point
and nearby persons to satisfy RF exposure compliance.

These devices are certified to Industry Canada RSS-213 and ICES-003.
This device complies with Industry Canada license exempt RSS standard(s). Operation is subject to
the following two conditions:
– This device may not cause interference, and
– This device must accept any interference, including interference that may cause undesired

operation of the device.
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts
de licence. L'exploitation est autorisée aux deux conditions suivantes:
– l'appareil ne doit pas produire de brouillage, et
– l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage

est susceptible d'en compromettre le fonctionnement.
Industry Canada Compliance Statement. This Class A digital apparatus complies with Canadian
ICES-003.
Avis de conformité à la réglementation d'Industrie Canada. Cet appareil numérique de la classe B est
conforme à la norme NMB-003 du Canada.
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1.4 Europe
Please dispose of the access point and beltpacks at the end of its operational life by taking it to the
closest collection point or recycling center.
This equipment is intended for use in professional audio intercom applications.
Equipment intended for sale in (ISO 3166-1, 2 letter country code): AT, BE, BG, CH, CY, CZ, DE, DK,
EE, ES, FI, FR, GB, GR, HR, HU, IE, IS, IT, LT, LU, LV, MT, NL, NO, PL, PT, RO, SE, SI, SK.
A license may be required to operate this equipment in certain regions. Consult the national authority
for possible requirements.
The full EC Declaration of Conformity for the TR-1000 and AP-1000 may be found at the following
website: www.rtsintercoms.com.
The full UK Declaration of Conformity for the TR-1000 and AP-1000 may be found at the following
website: www.rtsintercoms.com.

http://www.rtsintercoms.com
http://www.rtsintercoms.com
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2 Introduction
Welcome to the Quick Installation Guide for the TR-1000 Wireless Beltpack.

This guide is designed to help you set up and begin using your wireless communication system
quickly and efficiently.

The TR-1000 and AP-1000 are part of a high-performance wireless intercom solution, ideal for
professional environments where reliable, hands-free communication is essential. Whether you're
working in live event production, broadcast, theater, or industrial settings, this system offers robust
wireless connectivity, clear audio, and intuitive operation.

In this guide, you will find step-by-step instructions for:
– How to connect and configure the AP-1000 to an ODIN
– How to connect and configure the TR-1000 to an AP-1000
– How to subscribe the TR-1000 to an AP-1000

i
Notice!
This guide covers the set-up of a single AP system. For multi-AP system setups, refer to the NOMAD
Technical Manual.
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3 Controls and connections
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Figure 3.1: TR-1000 front and back views

Description

1 Speaker

2 Volume knobs

3 SEL/MENU

4 CALL

5 CLR/BACK

6 Belt clip - field replaceable

7 Magic arm mount - ¼-20 threaded insert

8 Battery contacts for charging
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Figure 3.2: TR-1000 Top, bottom, and side views

Description

1 Talk keys - backlight capable

2 Color display

3 Power/flashlight button

4 Flashlight - supports either white or red beam

5 XLR connector - field replaceable 4-pin male, 4-pin female and 5-pin female

6 Rubber plug for ingress protection (IP-65) over 3.5 mm Jack and USB-C

7 Battery release

8 Lanyard loops
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Figure 3.3: AP-1000 top and bottom reference view

1 Power LED

2 Online/Matrix connectivity LED

3 Location LED

4 Fault/Status LED

5 Door latch

6 Wall mount bracket hook

7 V-mount battery bracket mounting holes

8 Vertical or horizontal Manfrotto super clamp mounting holes

9 Spigot adapter (hex) mount lock thumb screw

10 North American camera mount (1/4-20)
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Figure 3.4: AP-1000 open reference view

1 4-pin XLR for power supply or battery

2 2 x GPO relay ports

3 Paper clip reset hole

4 PRI & SEC OMNEO connections with PoE capability

5 PRI & SEC dual fiber OMNEO connections
– Multi-mode SFP transceiver - FTLF8519P3BNL (F01U278503)
– Single-mode SFP transceiver - FTLF1318P3BTL (F01U278502)

6 Slot that accepts both types of Kensington lock

7 European camera or mic stand mount

8 Microphone stand mount (5/8-27)

9 Spigot adapter (hex) mount

10 North American camera mount (1/4-20)
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4 Connecting the system
IPedit is a software tool used for managing and editing IP addresses and related network
configurations. It typically allows users to modify IP address settings, manage DHCP assignments,
and handle DNS (Domain Name System) configurations.

Minimum required equipment
– AP-1000
– TR-1000 (one or more devices)
– ODIN
– Type-1 PoE switch (803.3af Class 3) or higher or a non-PoE switch with an AP-1000 DC power

supply
– 4 - Cat5e or better Ethernet cables
– PC, for system configuration

Before you begin:
– Ensure the AP-1000 is on and connected to the network.

Using the inline power supply
The AP-1000 includes an inline power supply, making it especially useful for temporary installations
where traditional PoE infrastructure may not be available.

Connect the inline power supply
1. Connect the power connector securely to the power inlet on the AP-1000.

2. Plug the power supply power cord into a standard mains power outlet or power strip.
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3. Connect an Ethernet cable to the Primary or Secondary Ethernet port.

Using PoE, PoE+, or PoE++
Power over Ethernet provides a reliable and efficient method for powering the AP-1000, eliminating
the need for separate electrical wiring and simplifying installation. This approach reduces
infrastructure costs while enabling centralized power management and backup through network
switches.
The AP-1000 also supports redundant PoE connections across multiple networks, ensuring glitch-free
operation even in the event of a power or network failure. By drawing power from more than one
PoE-enabled switch, the device maintains continuous uptime, which is critical for high-availability
wireless environments such as enterprise campuses, industrial sites, and temporary deployments.

i

Notice!
Keep in mind that PoE can transmit power and data over Ethernet cables for a maximum distance of
100 meters, or approximately 330 feet. Always plan cable runs accordingly to ensure reliable
performance and avoid power loss or connectivity issues.

The AP-1000 requires a Type- PoE switch (802.3af Class 3) or higher. Higher powered PoE+/PoE++
switches may also be used.

1. Connect one end of an Ethernet cable to a PoE-enabled switch.

2. Connect the other end of the Ethernet cable to either the PRI or SEC Ethernet ports on the
AP-1000.

4.1 Add ODIN to IPedit
Before you begin:
– Verify the ODIN is powered on.
– Note the IP address of the ODIN.

Steps
1. Open IPedit.
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2. From the Device menu, select Add.
The Add Devices Window appears.

3. Select the ODIN.
The Add button becomes active.

i
Notice!
If the device is not shown in the Available Devices list, click the Add tab, enter the device IP Address
manually, and then click the Find button.

4. Click Add.
The ODIN appears in the device catalog.

5. Click Done.
The Add Devices window closes.

4.2 Add AP-1000 to IPedit

Before you begin:
– Confirm the AP-1000 is powered on.

Steps
1. Open the IPedit software application.
2. From the Device menu, select Add.

The Add Devices screen opens.

3. In the Add Devices window, select the AP-1000.
AP-1000 devices are listed as NAP-10.
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4. Click Add.
The AP-1000 appears in the Device Catalog.

5. Click Done to close the window.

Troubleshooting
– If the AP-1000 does not appear, verify it is powered on and connected. Refresh the device list in

IPedit.
– To enter the IP address manually, click the Add tab, enter the IP address, and then click the Find

button.

4.3 Configure ODIN in IPedit
Steps
1. In the Device Name field, enter the device name.

i

Notice!
Changing the device name causes the device to reboot. It is not necessary to change the device
name. However, if changed, it is best to do this early in the setup so revisiting other devices that
connect to this device and updating them later is not necessary.

2. In the Description field, enter a description for ODIN, if desired.
Using the Channel Configuration and Status Pane

3. In the Channel Description field, enter a channel description, if applicable.
4. From the Destination Type drop down menu, select NAP-10.

i
Notice!
The Destination Type does not need to be selected if using the Browse window to select the device.
It fills the Type and IP Address automatically. The type is NAP-10.

5. Enter the device name in the Destination Device Name field.
OR
Enter the IP address of the device in the Destination IP Address field.
OR
Click the ... button.
The Discovered Devices Window appears.
– Expand the tree to view the destination devices available.
– From the expanded tree, select the destination device.
– Click OK.

6. Select the channel from the Destination Channel drop-down menu that connects to the ODIN.
7. Send the changes to the ODIN.

4.4 Configure AP-1000 and assign the TR-1000 in IPedit
In this step, you link the TR-1000 to a specific AP-1000 channel by using its BPID (Beltpack ID). This
process involves identifying the unique Beltpack ID associated with the desired AP-1000 channel,
which allows for precise communication and control between the TR-1000 and the AP-1000.

i

Notice!
By default, the system assigns all APs to Zone 1. If the user wants their TR-1000s to roam across a
multi-AP-1000 system, they must assign all APs to the same zone number. Consult the Technical
Manual for advanced set-ups.
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Before you begin:
– Note the AP-1000’s System ID and PIN (default: 0000) in IPedit. You will use this to subscribe

the TR-1000 to the AP-1000 in the next section.

i
Notice!
The user must sign in to IPedit with network administrator rights to complete these instructions.

Steps
1. From the Device Catalog on the left, select the AP-1000.

The Device Information pane populates.

2. Enter a unique description for the access point.
3. Verify the IP Address is correct, if using a Static IP Address.
4. (Optional) Select the Disable RSTP check box to disable the RSTP protocol.
5. Select the Preferred PTPv1 Leader check box to make the AP-1000 the system clock master.

!

Caution!
The NOMAD system requires a clock master that is more accurate than ODIN's internal clock. The
NOMAD AP-1000 contains a clock that meets the necessary accuracy requirements for proper
operation and must be made the clock master in systems that do not use standalone Master Clocks.
System administrators who make use of standalone Master Clocks should consult the NOMAD
technical manual to ensure the clock requirements are being met for proper operation.

i

Notice!
There can only be one active Master Clock in a system at a time. For NOMAD systems with multiple
access points, multiple AP-1000's can have the "Preferred PTPv1 Leader" check box selected. Even
though only one AP-1000 can be the active master at a given time, this will allow for other AP-1000
units to assume the role of Master Clock, if the primary Master were to fail.

6. Click the DECT tab at the top of the window.
The DECT page opens.
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7. Enter the system ID for the access point. This field accepts a 3-digit decimal number. The range
for this field is 1 through 254.

i
Notice!
All access points in a system must have the same System ID.

8. Enter the unique AP ID for the access point. 
The range for this field is 1-120.

i
Notice!
Every AP must have a unique ID within the same NOMAD system.

9. Set the PIN of the access point if you want to restrict TR-1000 subscription.
0000 is the default setting and does not prompt for a PIN for subscribing a TR-1000.
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10. Select the channel to configure (for example, Channel 1, etc).

i
Notice!
When setting up a multiple access point system, distribute the beltpacks equally among all access
points.

11. Enter a channel description, if applicable.
12. Select the ODIN to which the channel is connected.
13. Enter the name of the ODIN in the Destination Device Name field.

OR
Enter the IP address of the ODIN in the Destination IP Address field
OR
Click the browse button.
The Discovered Devices window appears.
– Expand the tree to view the available destination devices.
– Select the destination device.
– Click OK.

The Discovered Devices window closes.
14. Select the destination channel to which the channel is connected.
15. Power up the beltpack.

The BP ID displays on the front panel. This is a 10 digit, hexadecimal number in the format of:
BP03:b5:32:40:00.

16. In the IPedit DECT BPID field, enter the BP ID to assign to that channel.
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17. From the Changes menu, select Send.

18. From the File menu, click Save.

4.5 Put the AP-1000 into registration mode
Use the IPedit Configuration software to put the AP-1000 into registration mode so you can subscribe
the TR-1000 to the access point:
Once you activate registration mode, the AP-1000 opens its pairing window for the duration of time
you specify. During this time, you can initiate the subscription process on your TR-1000 . The access
point recognizes the beltpack's connection request, authenticates the device, and establishes a secure
communication link.
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For more information on subscribing the TR-1000, see Register the TR-1000 and connect to the
AP-1000.

Before you begin:
– Confirm the AP-1000 is on and connected to IPedit.

Steps

Use IPedit Configuration software
1. Open IPedit.
2. Click the Access Point tab

The Access Point page opens

3. Select the amount of time you want the AP-1000 to stay in registration mode.

4. Click the Enable DECT Registration button.
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The Status field changes to DECT Enabled and the Remaining (s) field starts the countdown timer.
This field shows the number of seconds the AP-1000 will stay in registration mode.

4.6 Subscribe the TR-1000 and connect to the AP-1000
Registering the TR-1000 to the AP-1000 wirelessly links the devices using the System ID and a PIN
Code, if configured.

Before you begin:
– Ensure the TR-1000 is within 40 feet (12 meters) of the AP-1000.
– Ensure the AP-1000 is in Registration mode. For more information, see Put the AP-1000 into

registration mode.

Steps
1. Turn on the TR-1000.

The front display turns on.
2. Press the MENU button.
3. Navigate to Setup.
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4. Press the Select button.
5. Navigate to the Registration menu.
6. Press the Select button.
7. Navigate to the Register? menu item.
8. When the AP-1000 System ID appears, press the Select button.

A Register message appears.

9. Using either encoder knob, move focus to the Register button.

10. Press the Select button
The TR-1000 registers with the AP-1000.

i
Notice!
If the AP-1000 has a PIN code, you must enter the code before Registration begins. See Registration
with PIN code below.

11. Verify the registration by looking at the TR-1000 home screen.
– The active DECT connection and RSSI icons indicate a successful subscription.

Red color Link down

Green color Link up/successful subscription
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12. Verify in IPedit that beltpack Status fields are populated.

Registration with PIN code
1. Complete steps 1 through 10.

The Enter PIN screen appears.
2. Enter the PIN.

Once you finish entering the PIN, the TR-1000 finishes the registration process.

Troubleshooting
If the subscription fails:
– Verify the System ID is correct in IPedit.
– If using a PIN code, verify the PIN is correct.
– Ensure the beltpack is close to the AP-1000 and retry.
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